Introduction

Functional Skills ICT

You live in a world where Information and Communication Technology (ICT) is used in almost every aspect of modern life, from business, education, media and banking to social networking and shopping. Computers in particular can be found everywhere you look – at home, at work, at school, at college and at university.

To get the most out of your own education and employment opportunities, you therefore need to be able to use computers confidently, effectively and independently. The Functional Skills syllabus seeks to give you that ability, providing the professional ICT skills needed to successfully use computers in every aspect of your daily life. In general this includes using ICT systems to accurately find, work with and communicate information of various types.

Aim of this book

The aim of this book is to provide the knowledge and skills necessary to achieve the Functional Skills ICT qualification. Step-by-step exercises are provided to guide you through the most useful features of popular Microsoft Office 2010 applications and to help build confidence in their use. Additional problem solving activities specific to your level are also included to reinforce learning.

Remember that achieving a Functional Skills ICT qualification is not just about knowing how to use a computer, but realising how to apply that practical knowledge to solve unfamiliar problems in all aspects of your life. The eight sections in this book are therefore based on a number of authentic work-related scenarios drawn from real life, each of which teaches a relevant set of skills that are highly valued in further education and employment.

After completing this book you will be able to:

- Select and use the best ICT tools and techniques to complete a given task
- Find and select the most appropriate information to complete a task
- Apply your knowledge and skills to plan, develop and evaluate suitable solutions
- Solve unfamiliar problems using a range of complex software features
- Manage information correctly and respond to problems
- Present and communicate information and engage with others
- Stay safe and respect laws and regulations
Skills and Assessment

At the end of each section you will be given two activities to complete on your own which require you to demonstrate the functional skills you have learned. Level 1 students should only attempt the first task, but level 2 students are encouraged to complete both. Each task is similar to the type of question you can expect to find in the assessment for this qualification. Sample solutions are also provided in the data files folder to allow you to compare your answers against the expected pass standard.

**Note:** Don’t forget to use the planning and review checklists at the back of the book to organise and evaluate your work.

**Level 1**

To achieve *Functional Skills ICT* at level 1 you must be able to demonstrate your ability to:

- identify the ICT requirements needed to plan and solve a simple, straightforward task
- use your own judgement to interact with ICT systems to meet the requirements of the task (and also know when to ask others for help and guidance)
- find and select information relevant to the task and apply a range of techniques to manage, develop, present and communicate that information
- act safely and securely and be able to evaluate your selection and use of ICT tools

**Level 2**

To achieve *Functional Skills ICT* at level 2 you must be able to demonstrate your ability to:

- plan solutions to complex, non-routine problems and select the correct ICT systems to meet the needs of the task
- break the ICT requirements down into smaller parts and tackle each using the most suitable tools available
- solve problems without requiring help and show that you can find, select, edit and manage information on your own
- apply a variety of advanced ICT techniques across several different applications in order to develop, present and communicate a solution
- act safely and securely and overcome challenges to produce successful solutions
Hi, my name’s Priti...

I’m a member of the ride construction team here at Big Planet Theme Park. We’ve just finished building a brand new roller coaster called Rumbling Rails – a thrilling high speed train ride through rocky canyons and icy mountain passes!

My role in the park’s construction team is to evaluate building plans and make sure environmental regulations are followed. Most of the time this involves using a computer to collect andanalyse data on-site. However, it’s also my job to communicate my findings to others in a variety of different ways. To do this I use the word processing application Microsoft Word to create professional reports and documents quickly and easily.

You have probably used Microsoft Word many times in your life already. If you’ve ever used a computer to write a letter, essay or short story then you will already know how to use basic word processing features. However, did you know that word processors are just as popular and useful in business? Indeed, people working in a variety of different professions use them all of the time to create a wide range of reports, memos, mailings and newsletters.

What you will learn:

In this section you will use the program Microsoft Word to help Priti complete a number of everyday tasks at Big Planet Theme Park. You will see how to use simple word processing techniques to design, create and edit professional documents for a variety of purposes.

Knowledge, skills and understanding:

- Use Microsoft Word to create and edit professional word-processed documents
- Learn how to use the best tools and features to solve a range of everyday problems
- Apply professional editing, formatting and layout techniques

Data files

Data files needed to complete the activities in this section are provided in the Section 3 data files folder. Documents that you create or edit can be saved to the same folder.
3.15 Line and Paragraph Spacing

You can improve the appearance and readability of a document by changing line spacing – the white space that appears between lines of text. By default, line spacing is 1.15. Other commonly used spacing is Single, Double and 1½.

Activity:

1. The file Staffing should still be open from the previous exercise. Select the 5 paragraphs of text underneath the heading Memo.

2. In the Paragraph group, click the Line and Paragraph Spacing button.

3. From the drop-down list that appears, select 2.0 (also known as Double) to change the line spacing for the document. Notice that the spacing between lines increases.

4. Display the Page Layout tab. The Paragraph group contains controls to change the spacing before and after each paragraph (this is different from line spacing).

5. To leave space after the selected paragraphs, increase the value in the After box to 24 pt. All selected paragraphs will now gain a 24 pt space underneath the last line of text.

Note: As with fonts, line spacing is measured in points (shortened to pt).

6. Launch the Paragraph dialog box. Notice that the settings which have been made are displayed under the Spacing heading.
7. Change the paragraph spacing After to 0 pt and the spacing Before to 12 pt. Change the Line spacing to Single (1.0) and then click OK. Notice the effect of these changes.

Note: Spacing added after one paragraph and before the next will overlap.

8. Save the document as staffing complete and close it.

3.16 Styles

For simple, short documents, the basic tools on the Home tab are more than sufficient for formatting text. However, for longer or more complex documents you need to create and use styles. Styles are specific combinations of font types, sizes and alignments which help ensure consistent formatting throughout a document. When applied, the selected text or current paragraph will adopt all of the style’s format and alignment settings.

Activity:

1. Open the document Plan. This file contains information on the future maintenance of the Rumbling Rails ride. Notice that there are a number of bold headers followed by a brief description in plain text.

2. Display the Home tab and locate the Styles group. The options provided here allow you to apply new styles to the text in your documents.

3. Notice that the style Heading 1 is currently highlighted. This means that the cursor is placed in a paragraph of text which has the Heading 1 style applied.

4. Place the cursor on the second line of text containing the date; the style Heading 2 is highlighted (you may need to click More to see this). Next, place the cursor on the third line containing the two lines of introductory text; the style Normal is highlighted.

Note: The highlighted styles are built-in styles that were added when the document was created. It is common practice to use Heading 1 for main titles, Heading 2 for subtitles, and so on. Normal is used for the main body text of a document.
5. With the cursor positioned in the third paragraph, select **Heading 1** from the **Styles** box. The text changes to match the **Heading 1** style.

6. Select **Normal** from the **Styles** box to restore the text’s formatting.

**Note:** Once you have applied a style it is very easy to change it. Changing a style will also change all the parts of your document that use it.

7. Open the **Styles** task pane by clicking the **Styles** launcher button.

8. Notice that **Normal** is currently selected. Place the cursor in the subheading text **Ride Improvements**. The style **Heading 3** is selected.

9. Move your mouse pointer over the selected style on the **Styles** task pane. Click once on the drop-down arrow that appears and then click **Modify**.

10. The **Modify Style** dialog box appears. From this dialog box you can change all formatting and alignment settings for the selected style.

11. Underneath the **Formatting** heading, change the **Font** to **Arial** and the size to 14. Select **Underline** and a font colour of **Dark Blue**.

**Note:** Options to alter **Paragraphs, Tabs** and **Borders** for the selected style can be found by clicking the **Format** button, at the bottom of the dialog box.

12. Click **OK**. The style is updated and all paragraphs that are based on it are changed.

13. Use this technique to change the **Normal** style to use the font **Times New Roman** size 20.
14. There are a number of built-in style sets that can be used to give your documents a professional look. From the Styles group, click the Change Styles button. From the submenu that appears, click Style Set.

15. Move your mouse over each of the style sets shown and the result of applying each will be previewed in the document.

16. Finally, click Modern to apply that style set. This replaces the formatting options for each of the built-in styles (and any text based on them will be updated).

Note: Completely new styles can be created by clicking the New Style button, on the Styles task pane and then specifying font formatting and alignment settings.

17. Close the Styles task pane.

18. Save the document as maintenance plan and close it.

3.17 Creating a Table

Word’s Table feature provides a really effective way of presenting data in a clear and easy to read format. Tables consist of rows (running from top to bottom) and columns (running from left to right) to create a number of cells that can contain text. The table can also be formatted to create a more professional, eye catching document.

<table>
<thead>
<tr>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scaffolding</td>
<td>Mira</td>
<td>Mira/Alan</td>
<td>Atsu</td>
<td>Mira</td>
</tr>
<tr>
<td>Train Install</td>
<td>Chen</td>
<td>Chen</td>
<td>Priti</td>
<td>Priti</td>
</tr>
<tr>
<td>System Test</td>
<td>Priti</td>
<td>Priti</td>
<td>Chen</td>
<td>Chen</td>
</tr>
<tr>
<td>Landscaping</td>
<td>Dave</td>
<td>Ali</td>
<td>Dave</td>
<td>Ali</td>
</tr>
<tr>
<td>Labouring</td>
<td>Atsu/Paul</td>
<td>Dave/Mira</td>
<td>Atsu/Paul</td>
<td>Atsu/Paul</td>
</tr>
</tbody>
</table>

Activity:

1. Start a new, blank document.

2. To create a new table, display the Insert tab and click the Table button. When the grid appears, click Insert Table at the bottom of the menu.

Note: A table can also be created directly from the Table drop-down button by moving your mouse pointer over the required number of cells on the grid and clicking once.

3. The Insert Table dialog box appears.
4. Enter 6 in the **Number of columns** box and 6 in the **Number of rows** box (these numbers can be typed in directly or the up/down spinners can be used).

![Insert Table](image)

5. Click **OK** to create the table. It appears at the location of the cursor. Once a table has been created, it is simple to enter text and move around within it.

**Note:** It is often easier to enter text into a table first and then format it later (i.e. add colour, adjust text size, correct column widths, etc).

6. The cursor should be flashing inside the first cell. If it is not, click once in the top left cell to place it.

![Blank Table](image)

**Note:** You can use the **<Tab>** key to move to the next cell in a table and **<Shift Tab>** to move backwards. When entering text, only use **<Enter>** when a new line is required within the same cell.

7. Using the **<Tab>** key to move between cells, enter the following text:

<table>
<thead>
<tr>
<th></th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scaffolding</strong></td>
<td>Mira</td>
<td>Atsu/Alan</td>
<td>Mira/Alan</td>
<td>Atsu</td>
<td>Mira</td>
</tr>
<tr>
<td><strong>Train Install</strong></td>
<td>Chen</td>
<td>Chen</td>
<td>Chen</td>
<td>Priti</td>
<td>Priti</td>
</tr>
<tr>
<td><strong>System Test</strong></td>
<td>Priti</td>
<td>Priti</td>
<td>Priti</td>
<td>Chen</td>
<td>Chen</td>
</tr>
<tr>
<td><strong>Landscaping</strong></td>
<td>Dave</td>
<td>Ali</td>
<td>Dave</td>
<td>Ali</td>
<td>Ali</td>
</tr>
<tr>
<td><strong>Labouring</strong></td>
<td>Atsu/Paul</td>
<td>Dave/Mira</td>
<td>Atsu/Paul</td>
<td>Dave/Mira</td>
<td>Atsu/Paul</td>
</tr>
</tbody>
</table>

**Note:** When the cursor is in the last cell of a row, pressing **<Tab>** will move the cursor to the first cell on the next row.

8. Save the document as **staff roster** and leave it open for the next exercise.
3.18 Move or Resize a Table

Once a table has been created, you can easily move it to a different position on the page and increase or decrease its size to suit your document.

Activity:

1. The document staff roster created in the previous exercise should still be open.
2. Rest the mouse pointer over the table until the Table Move Handle, +, appears at the top left corner.

Note: If the Table Move Handle does not appear, make sure Print Layout view is displayed by selecting the View tab and then clicking Print Layout. This view will show the document as it will appear on the printed page.

3. Now move the mouse over the Table Move Handle until a four-headed arrow appears.

4. You can now move the table anywhere on the page. Click and drag the Table Move Handle downward to move the table about half way down the page.
5. Rest the mouse pointer over the table again until the Table Resize Handle, □, appears at the bottom right corner. This allows you to resize the table to any size you like.
6. Now move the mouse pointer over the Table Resize Handle until a double headed arrow appears.

7. Drag the mouse down a little until the table is about twice its original height.
8. Now use the Table Resize Handle to return the table to approximately its original size.
9. Use the Table Move Handle to move the table back to the top of the page again.
10. Leave the document open for the next exercise.

3.19 Selecting Cells

You need to be able to select table cells before you can do anything to them, just as a block of text must be selected before it can be formatted. Unfortunately, selecting cells can sometimes be a tricky and frustrating business, but there are a number of techniques to help you.
Activity:

1. Select the first cell containing the word **Scaffolding** by moving inside the left edge of the cell and clicking the left mouse button once when the selection arrow appears, ![Selection Arrow](image1).

![Scaffolding](image2)

2. The entire cell and its contents are now selected. Make the text bold by clicking the **Bold** button, ![Bold Button](image3), on the **Home** tab.

3. Move the mouse pointer over the inside left edge of the cell above and double-click the left mouse button when the pointer changes to ![Selection Arrow](image4). The entire row is selected.

<table>
<thead>
<tr>
<th>Scaffolding</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mira</td>
<td>Atsu/Alan</td>
<td>Mira/Alan</td>
<td></td>
</tr>
</tbody>
</table>

4. Click the **Bold** button again to make all of the cells in the first row bold.

5. Next, move the mouse pointer just below the top edge of the first column until the selection arrow is displayed again. Click once to select the entire column.

<table>
<thead>
<tr>
<th>Scaffolding</th>
<th>Train Install</th>
<th>System Test</th>
<th>Landscaping</th>
<th>Labouring</th>
</tr>
</thead>
</table>

6. Click the **Bold** button. This first removes the **Bold** setting applied to **Scaffolding** earlier, so click again to make all of the cells in the first column bold.

7. Now move your mouse pointer over the cell containing the name **Mira**. Click and drag to select this cell and the 24 cells below and to the right.

<table>
<thead>
<tr>
<th>Scaffolding</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mira</td>
<td>Atsu/Alan</td>
<td>Mira/Alan</td>
<td>Atsu</td>
<td>Mira</td>
<td></td>
</tr>
<tr>
<td>Train Install</td>
<td>Chan</td>
<td>Chan</td>
<td>Chen</td>
<td>Priti</td>
<td>Priti</td>
</tr>
<tr>
<td>System Test</td>
<td>Priti</td>
<td>Priti</td>
<td>Priti</td>
<td>Chen</td>
<td>Chen</td>
</tr>
<tr>
<td>Landscaping</td>
<td>Dave</td>
<td>Ali</td>
<td>Dave</td>
<td>Ali</td>
<td>All</td>
</tr>
<tr>
<td>Labouring</td>
<td>Atsu/Paul</td>
<td>Dave/Mira</td>
<td>Atsu/Paul</td>
<td>Dave/Mira</td>
<td>Atsu/Paul</td>
</tr>
</tbody>
</table>

8. Click the **Italic** button, ![Italic Button](image5), to make all of the text in the selected cells italic.

9. To select the entire table, move the mouse over the **Table Move Handle** and click once.

10. Next, use the **Font Color** button’s drop-down arrow, ![Font Color](image6), to change all of the text to **Dark Blue**. Leave the document open for the next exercise.
Develop Your Skills...

At the end of every section you will get the chance to complete two full tasks without my assistance. This will help to reinforce learning and develop your skills. Don’t forget to use the planning and review checklists at the back of the book to organise and evaluate your work.

Note: Sample solutions for both tasks are provided in this section’s data files folder.

Level 1: Rumbling Rails Mail Shot

In this task you will be asked to create a simple mail shot for Priti. You will need to use the ICT skills you have learned in this section to plan, develop and present an appropriate solution. You can ask for help from friends, colleagues or a teacher if you get stuck.

Level 1 Task

Did I tell you that our new Rumbling Rails roller coaster is a massive 100 metres high and will reach speeds of 80 miles per hour? It’s now the biggest and best ride in the theme park, and to celebrate our “grand opening” we are planning to hold a party next week for park staff.

To advertise the event and inform all park employees about the new ride, I need you to design and produce a simple one page mail shot from scratch. It doesn’t need to look too fancy, but it must be interesting and informative and include details on party times and ride opening dates. Information for the mail shot is available in the following files:

- **Rumbling Rails** A document containing background information on the new ride and the grand opening party dates
- **Photo** An image file containing a photograph of the new ride
- **Logo** An image file containing the theme park’s logo

Start by creating a new document and then add the contents of the Rumbling Rails file. Insert and arrange the Photo and Logo images as appropriate. Remember: the mail shot will be read by all park employees so it needs to look professional and be easy to read! When you are finished, save the document as mail shot.
Level 2: Financial Report

In this task you will be asked to create a detailed report for Priti’s boss. You will need to use the advanced ICT skills that you have learned in this section to create a suitable solution (you may need to break the problem down into smaller parts first). Only level 2 students should attempt this task and it should be completed without help from others.

Level 2 Task

I’ve just received the following e-mail from Monty Spangles, the owner of the park:

I’ve not got much time so will you help me prepare the report? You will need to create a new, well-presented document for Monty that looks professional and is easy to read. Include a table showing the cost data in the Final Costs file. Unfortunately, I forgot to add Maintenance to the list which cost £2500 – will you make sure this is included too?

To help Monty understand the contents of the document, describe the table of costs in one or two sentences. Also mention that the reason the cost of Train components has increased by approximately £100,000 was due to the purchase of a third train (which will enter operation next month). If Monty has any questions about the report he can contact me on telephone extension 0456.

Insert the Logo file so that the document meets the park’s house style (all official Big Planet Theme Park documents must contain the park logo in the top right corner). When you are finished, save the document as cost report.

Monty,

Would you create a report for me please on how much the new Rumbling Rails roller coaster has cost the company? I need it on my desk first thing in the morning.

Best regards,

Priti
I’m a member of the engineering and maintenance department here at Big Planet Theme Park. My team and I are responsible for making sure that all of the rides are properly maintained and safe for visitors. Just imagine what would happen if the Haunted Castle ride broke down when people were half way through it!

My main role at the park is to reduce costly breakdowns and help develop ways to improve the overall safety and reliability of the rides. I have plenty of mechanical and engineering jobs to keep me busy, but I also spend a lot of time creating spreadsheets to manage my team’s budget. We only have a small amount of money to spend, but if we invest it properly, the life of our rides will be extended and the park will save a lot of money in the long run.

To help me keep track of my team’s spending, I use the program Microsoft Excel. Many professionals in various types of organisation use this program – it’s really useful for working with numbers and performing calculations quickly and accurately. It also allows me to present complex data graphically, making it much easier to understand and communicate to others.

**What you will learn:**

In this section you will use the program Microsoft Excel to help Zak complete a number of everyday tasks at Big Planet Theme Park. You will see how to use simple spreadsheet techniques to enter, develop and organise numerical information for a variety of purposes.

Knowledge, skills and understanding:

- Use Microsoft Excel to create spreadsheets and manipulate numerical data
- Learn the best tools and features to solve a range of everyday problems
- Apply a variety of professional editing, formatting and layout techniques

**Data files**

Data files needed to complete the activities in this section are provided in the Section 4 data files folder. Spreadsheets that you create or edit can be saved to the same folder.
4.1 Using Microsoft Excel

Microsoft Excel is most commonly used to work with figures and is a perfect choice of application for any task that involves numbers. Once a spreadsheet has been set up correctly, it can be used to perform a number of complex calculations quickly and accurately (and any results will be automatically updated when the data is changed). Typically, spreadsheets can be used to help with the following tasks:

- Maths problems, budgets and accounting
- Cash flows and forecasts
- Data analysis

A spreadsheet stores information in a grid of cells, which generally contain text, numbers or formulas. Cells are arranged in rows (across the screen) and columns (down the screen), forming a worksheet. One or more worksheets are together known as a workbook, the name Excel gives to a saved file.

Notice the numbers running down the left side of the spreadsheet and the letters running across the top. These are called Heading Bars and are used to reference cells. In the picture above, the cell B5 is currently selected (the location where Column B and Row 5 intersect). This is highlighted on the Heading Bars and shown in the Name box.

**Note:** When referring to a cell, the column letter always comes before the row number.

**Note:** Although mainly used for working with numbers, people also use spreadsheets for creating and working with simple lists of data (e.g. product lists, stock lists, customer contact lists, etc).
Spreadsheets can also take basic data and present it in a variety of attractive graphs and charts. One important advantage of this is that the graphics created are much easier to understand at a glance. They can also be really useful for including in other documents or presentations.

4.2 Creating a Spreadsheet

When creating a spreadsheet you should start on Sheet1 (the default worksheet) and begin entering data in the top left corner. You should also add labels to the top of columns or the start of rows to help describe the contents of the worksheet.

It is very important to enter numbers correctly and accurately. If you make mistakes the spreadsheet will produce the wrong results.

Activity:

1. Start Excel. A blank workbook is created by default.

   Note: Notice that cell A1 is currently selected (it is the active cell). The workbook contains three worksheets by default; Sheet1, Sheet2, Sheet3.

2. A label is entered into a cell by typing. Type Maintenance checks week 7.

   Note: When entering text into a cell, notice that it also appears in the Formula Bar.

3. To complete the cell entry, press <Enter>. The active cell moves down to cell A2.
4. You can move to other cells by pointing and clicking or by using the arrow keys on your keyboard. Press the down arrow key, ↓, to move to cell A3, and then type Staff.

5. Next, press → to move to cell B3 (you do not need to press <Enter> to confirm an entry).

6. The worksheet that you are creating is to be used to record daily safety checks for the park’s engineering and maintenance team. Enter data as shown below.

7. The actual maintenance figures now need to be entered. Move to cell B4 by clicking it and then enter the number 16. Enter the data below using whichever technique you like to move between cells (note that each employee has two days off).

Note: The text looks as though it also occupies cells B1 and C1, but this is not the case. A label will expand and appear on top of other cells if – and only if – the other cells are empty. Cells containing numbers do not do this.

Note: Notice that numbers appear right aligned by default. This helps you to tell at a glance which cells contain text and which cells contain numbers.

Note: You can change a worksheet’s name simply by double clicking the relevant tab at the bottom of the screen and typing a new title.
8. Double click the current worksheet’s title tab (Sheet1) and enter the title **Maintenance**.

![Worksheet](image)

9. Press <Enter>. The worksheet has been renamed.

10. Click the Sheet2 tab to display that worksheet. Click the **Maintenance** tab again to return to the first sheet.

**Note:** To add a new worksheet to your workbook, click the **Insert Worksheet** button. It is a good idea to keep all relevant worksheets in the same workbook.

11. Display Sheet2 again. From the Cells group on the Home tab, click the drop-down arrow on the **Delete** button and select **Delete Sheet**.

![Delete Sheet](image)

12. The worksheet is deleted and the next available sheet selected. Delete Sheet3 also, leaving only the **Maintenance** worksheet remaining.

**Note:** In the same way that you can protect documents in Microsoft Word, you can also protect workbooks in Excel. For instance, your spreadsheets can be password protected or marked as Final so that changes are discouraged.

13. Save the workbook as **maintenance** and then close it.

### 4.3 Resizing Columns and Rows

You may sometimes need to change column widths and row heights to better display the contents of cells and to make your spreadsheets easier to read. This is simply done by dragging the column or row boundaries on the relevant **Heading Bar**.

**Activity:**

1. Open the workbook **Attendance**. This file contains information on visitor numbers to five specific **Haunted Castle** attractions. Unfortunately, it has been very poorly designed and many of the labels have been obscured.
2. Move your mouse pointer to the boundary line between column A and column B in the column **Heading Bar**. The pointer changes to a double-headed arrow, \( \leftrightarrow \).

3. Using click and drag, reduce the width of column A to approximately **20.00** (the column’s width is shown in a **ToolTip** as you drag).

4. Using the same technique, increase the widths of columns B, C, D and E to **17.00**.

5. Row 2 is too small (in height) to contain the text contained in A2. Place the mouse pointer over the border between row 2 and 3 on the row **Heading Bar**, and using click and drag, increase the height of row 2 to approximately **24.00**.

6. Use the **Zoom Slider** on the **Status Bar** to increase the zoom level to **150%**.

7. Use the **Zoom Slider** to restore the zoom level to **100%**.

8. Save the workbook as **visitors** and close it. You will use this file again later.

**Note:** Width is measured in number of characters (20 will show 20 standard characters).

**Note:** For more precision, right click a column header and select **Column Width**. You can then enter a precise value. To adjust a row, right click and select **Row Height**.

**Note:** Similar to **Microsoft Word**, Excel also has a **Zoom** feature on the **Status Bar** for zooming into worksheets.

**Note:** You can continue this section using any zoom level that you feel comfortable with.
4.4 Basic Formulas

**Formulas** are used to calculate results from numbers entered in a spreadsheet. For example, formulas can be used to add a column or row of numbers together to obtain a total. If the data is changed, the formula will automatically recalculate the result.

**Activity:**

1. Display the File tab and start a new, blank workbook.
2. In cell **B2** enter **34** and in cell **B3** enter **16**.
3. Make **B5** the active cell by clicking on it.
4. To add the contents of **B2** and **B3** together and display the result in **B5**, type in the formula **=b2+b3** and press <Enter>.

**Note:** Although it is common practice to start creating spreadsheets from the upper left corner, you do not always need to start in cell **A1**. In fact, you can enter data in any cell that you like.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>34</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>16</td>
</tr>
</tbody>
</table>

5. Cell **B5** now displays the result of adding cells **B2** and **B3** together (**50**).
6. Click cell **B5** and notice that the **Formula Bar** displays **=B2+B3**, the formula for this cell.

**Note:** All formulas begin with an equals sign, =, followed by the calculation. Cell references are used so that results are recalculated if data in those cells change.

7. Click in cell **B3** and enter **26** to overwrite the original contents.
8. Press <Enter> and the formula updates **B5** to **60**, the new solution.

**Note:** It is usually quicker to use the numeric keypad on the right of a standard keyboard for entering large amounts of numbers. However, you may need to activate the **Num Lock** feature on your keyboard first by pressing the <Num Lock> key (a light on your keyboard will appear when it is activated).

9. Close the workbook **without** saving.

**Note:** You will learn a lot more about formulas as you progress through this section.
4.5 Mathematical Operators

The basic mathematical operators are *add*, *subtract*, *multiply* and *divide*. You will need to use these operators in your formulas to produce calculations (you have already used *add* in the previous exercise). However, the symbols for these operators on a keyboard are slightly different to those that you may be used to.

+ Add
- Subtract
* Multiply
/ Divide

These symbols appear twice on the keyboard; one set is placed around the main keyboard and the other set is placed on the numeric keypad. Many people find that the numeric keypad is easier to use because the keys are closer together and the <Shift> key is not needed.

**Activity:**

1. Open the workbook *Operators*.
2. Make B6 the active cell by clicking on it, and then type in =B4+B5.

3. Press <Enter>. This creates a formula to add the contents of cells B4 and B5. The answer is displayed as 9.

**Note:** Notice that, as you type the formula, the referenced cells are highlighted on the worksheet. Lower case (small) letters will be automatically capitalised.

4. Click in cell C6 and enter the formula to subtract the two numbers above, =C4-C5. Rather than press <Enter>, press the right arrow key, ➔. The answer is displayed as 3.

**Note:** Have you noticed the pop-up menu that appears when you enter formulas? This is used to create more complex formulas which you will learn more about later.

5. In cell D6, enter the formula to multiply the two numbers above, =D4*D5. The answer is displayed as 15.

6. In cell E6, enter the formula to divide the two numbers above, =E4/E5. Press <Enter> and the answer is displayed as 3.
7. Save the workbook as operators complete and close it.

### 4.6 Brackets

If more than one operator is used in a single formula, the order they appear is very important. For the four operators that you have seen so far, Excel performs calculations in this order: **Brackets**, **Division**, **Multiplication**, **Addition** and finally **Subtraction** (the **BODMAS** rule in maths). As brackets come first, they can be used to force Excel to perform calculations in a different order.

For example, in the formula $A1+A2/A3$, the value in cell $A2$ would be divided by $A3$ first and then added to $A1$. However, brackets can be used to make sure $A1$ is added to $A2$ first before being divided by $A3$, as the following formula shows: $(A1+A2)/A3$.

**Activity:**

1. Zak has asked you to work out how many people are able to ride the Haunted Castle’s Black Hole attraction at a time. Start a new, blank workbook.

2. The Black Hole ride has two trains which always leave together. Each train has 10 cars and each car can hold a maximum of 4 passengers. Starting in B2, enter the following data (and increase the size of the columns so that the labels all fit).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Passengers per car</td>
<td>Train 1 cars</td>
<td>Train 2 cars</td>
<td>Capacity</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

3. To work out how many people can ride the attraction – its capacity – the number of passengers per car must be multiplied by the total number of cars for both trains.

4. Click on cell E3 and type the formula $=b3*c3+d3$. Press <Enter> and the answer given is 50. Unfortunately, this is wrong – but can you tell why?

5. Due to the rules of **BODMAS**, the multiplication was carried out before the addition. Click on cell E3 and press the <Delete> key to remove the formula.

6. This time you will use brackets to make sure the addition occurs first. Type in the following formula instead: $=b3*(c3+d3)$ and press <Enter>. 

7. Check that the answer displayed is now **80**; passengers per car multiplied by the total number of cars.

<table>
<thead>
<tr>
<th>Passengers per car</th>
<th>Train 1 cars</th>
<th>Train 2 cars</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>4</strong></td>
<td><strong>10</strong></td>
<td><strong>10</strong></td>
<td><strong>80</strong></td>
</tr>
</tbody>
</table>

**Note:** Brackets can also be placed inside of other brackets.

8. Good job. Save the workbook as **capacity** and close it.

### 4.7 Percentages

**Percentage** means “per hundred” and is a technique used frequently in business and everyday life to describe a fraction out of 100. It is always displayed with a percentage symbol, %. For example, **20%** is **20/100** as a fraction or **0.2** as a decimal. In the pie chart below, **20%** has been cut out leaving **80%** remaining.

In **Excel** there is a **Percent Style** button, %, that changes a decimal to a percentage automatically.

**Activity:**

1. For a report that Zak is creating, you have been asked to work out what percentage of special effects on the **Black Hole** ride are “pop-up ghosts”.

2. Create a new, blank workbook. Starting in **B2**, enter the following data (resize any columns as necessary).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Pop-up Ghosts</td>
<td>All Special Effects</td>
<td>Percentage</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>5</td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

3. To display the number of pop-up ghosts as a percentage of all special effects, enter the formula **=B3/C3** into **D3**. Press <Enter>.
SECTION 5
Microsoft PowerPoint
Hi, my name’s Yan...

I’m the head of ride design here at Big Planet Theme Park, and it’s my job to create the blueprints for new rides and attractions. For my current project I’ve been asked to redesign Demon of the Deep, one of our older and less popular rides.

The Demon of the Deep log flume used to be one of the park’s best attractions, but times and tastes change. It’s now my responsibility to produce new ideas for improving the ride, from initial concepts and rough sketches through to fully developed models and working simulations. As I often work on my own, I need to manage my own time and stay focused to meet my deadlines.

I’ve already come up with a few new ideas to help improve the ride, and I plan to present these to park managers at a meeting in a few days time. To help me, I will use the application Microsoft PowerPoint to create a professional presentation quickly and easily. In fact, as you are here, maybe we can create the presentation together?

What you will learn:

In this section you will use the program Microsoft PowerPoint to help Yan design, create and edit a presentation. IMPORTANT: You will need to pay close attention and follow all of Yan’s instructions carefully, as each exercise builds on the last to create a complete presentation.

Knowledge, skills and understanding:

- Use Microsoft PowerPoint to create and edit eye-catching presentations
- Apply a range of professional formatting and layout techniques
- Choose and display information that is relevant for the audience
- Select suitable animations and themes

Data files

Data files needed to complete the activities in this section are provided in the Section 5 data files folder. Presentations that you create or edit can be saved to the same folder.
5.1 Using Microsoft PowerPoint

In both business and education, people are often asked to give a talk on a specific topic such as a new idea, product or service. People are also frequently required to present the results of their work or the findings of their research to other interested parties. To help lead the delivery of their talk, presentation software is used.

Microsoft PowerPoint is an application that is an appropriate choice for any task that requires you to create, edit and give a presentation. It allows you to create a number of single slides containing key points on one or more topics. When combined in a sequence, the slides form a slide show that can be used to accompany your talk.

Note: It is a well known fact that most people do not enjoy public speaking. Fortunately, creating a slide show to accompany a presentation can really help. It can aid your memory and help get important points across to the audience.

Note: Presentations are most often displayed using an overhead projector, monitor, or digital whiteboard. However, you can also use PowerPoint to save a slide show as a sequence of web pages or printed handouts.

The formatting of text and images is handled easily by PowerPoint, as is the ability to include different types of objects such as videos, music and charts. Perhaps more important is the application’s ability to present information using a variety of professional text and background styles. To capture your audience’s attention, a range of advanced animation effects can also be used to bring your presentation to life.
5.2 Creating a Presentation

*PowerPoint* features a variety of ready-made templates that you can use to create very impressive and professional presentations. However, it is recommended that you start from a blank template and focus on your presentation’s content first. You can then apply formatting later.

**Activity:**


![PowerPoint window with Slide thumbnail, Slides pane, Boundary bar, and Notes pane]

**Note:** You can also create a new Blank presentation using the File tab.

2. Examine the *PowerPoint* window. In particular, locate the familiar File tab, Ribbon, Status Bar, Quick Access Toolbar and Zoom controls.

3. Locate the Slides pane on the left of the window. This will display a small preview of all the slides in your presentation (known as thumbnail images). Clicking a thumbnail will open the full slide in the main editing window.

4. Locate the Notes pane at the bottom of the window. This can be used to add notes to each slide which can be printed and used by a speaker during a presentation.

**Note:** The various panes can be resized or hidden by dragging their boundary bars.

5. Leave the blank presentation open for the next exercise.
5.3 Slide Layouts

PowerPoint features a number of built-in slide layouts that can be used to quickly create new slides. Each layout features a slightly different arrangement of placeholders that you can use to enter your slide’s content.

Activity:

1. Examine the layout of the single blank slide currently on-screen. This slide has a Title Slide layout (i.e. the slide is designed to be the first screen in a presentation).

2. With the Home tab selected, click the Layout button, in the Slides group. A list of other slide layout types appears (notice that Title Slide is already selected).

3. Select Title and Content from the list. The current slide’s layout is changed.

4. Select each of the remaining 7 slide layouts in turn and observe how each one affects the slide. Consider the possible uses for each of the layout types.

Note: The position of items on each slide layout can be changed using click and drag. To restore a slide back to its default layout, use the Reset button in the Slides group.

5. Return the current slide to its original Title Slide layout and leave the presentation open.

5.4 Adding and Removing Slides

New slides can easily be added to a presentation at any time using any slide layout you wish. It is also easy to remove any unwanted slides.
Activity:

1. With the default blank presentation open on screen, click the New Slide button in the Slides group on the Home tab.

Note: Clicking the drop-down arrow on the New Slide button will let you add a new slide using any of the 9 available layout types.

2. A new slide with Title and Content layout is created and added to the slide show. It appears on the Slides pane and is automatically selected.

3. Use the drop-down arrow on the New Slide button to add a slide with Two Content layout. There are now 3 slides in the presentation.

Note: Notice that the slides are automatically numbered in the Slides pane.

4. Using the Slides pane, click once on slide 1. The slide thumbnail is selected and appears in the main editing window. Use the same technique to select slide 2.

Note: To delete a slide, simply select it in the Slides pane and press <Delete>.

5. Using the Slides pane, click once on slide 3. Press the <Delete> key on your keyboard to remove the slide (leaving two slides remaining).

6. Select slide 1 and leave it open for the next exercise.

5.5 Entering Text

Text can be added to a slide by simply clicking once within the boundaries of a placeholder and typing. The default “Click to add...” prompt will automatically disappear.

Activity:

1. Slide 1 should currently be selected in the Slides pane. Click once in the placeholder box labelled Click to add title. The default prompt text disappears.

2. Let’s start creating the presentation for Yan’s meeting. Enter the presentation title Demon of the Deep.
3. Click in the second placeholder to add a subtitle, and then type Redesign Ideas. Notice that the first thumbnail on the Slides pane has been updated to reflect the changes.

**Note:** All of the standard text formatting options such as Bold, Italic, Underline, Font and Font Size are available on the Home tab in the Font group. Familiar text alignment options such as Line Spacing are also available in the Paragraph group.

4. Display slide 2, click once in the top placeholder and enter the text Project Introduction.

**Note:** In general, most PowerPoint slides should only contain brief bulleted points that help to emphasize key points in your presentation.

5. Click once in the lower placeholder and enter the text Demon of the Deep ride is getting old. Notice that this slide layout automatically includes bulleted points. Press <Enter>.

- Demon of the Deep ride is getting old

6. Enter the following key points, pressing <Enter> after each one.

   Ride suffers from frequent breakdowns
   Gives a bad impression of the park
   Used to be very popular, but not any more
   Too expensive to replace the ride
   Needs a redesign to attract new visitors

7. Save the presentation as redesign (in the data files folder for this section) and leave it open for the next exercise.

### 5.6 Running a Presentation

Once you have created one or more slides, you can run a presentation in Slide Show view. This will display the presentation as it will be seen by your audience, and is useful for testing that everything works and that the presentation appears as you expect.

**Activity:**

1. Slide 2 should currently be selected in the Slides pane. Display the Slide Show tab and click From Beginning in the Start Slide Show group.

2. The presentation runs and slide 1 fills the screen. Click your left mouse button once to move to the next slide (alternatively you can press <Space> or <→>). Click once more to reach the end of the slide show where a black screen appears.
Hi, my name’s Julia...

I’m the manager of the marketing department at Big Planet Theme Park. I’m currently working with staff at the Laser Show to help advertise their brilliant new attraction, *The Light Fantastic*.

This amazing show uses the latest computer technology to control hundreds of lights and lasers in time to music. Lasting 20 minutes, the performance combines pictures and special effects to recreate famous cities and landmarks from around the world – it really is unmissable event. In fact, park management expects *The Light Fantastic* to be so popular that they have decided to run the show six times each day.

Working in marketing, it is my job to create an advertising campaign to publicise the new attraction and its show times. To do this, I plan to use the desktop publishing application Microsoft Publisher to create a range of eye-catching and informative posters, flyers, brochures, leaflets and newsletters. There’s a lot of work to do and a lot of different types of advertising publication to create – maybe you can help?

**What you will learn:**

In this chapter you will use the program Microsoft Publisher to help Julia complete a number of everyday tasks at Big Planet Theme Park. You will see how to use simple desktop publishing techniques to design, create and edit professional publications for a variety of purposes.

Knowledge, skills and understanding:

- Use Microsoft Publisher to create and edit professional publications
- Manipulate graphics and text using a range of editing, formatting and layout techniques
- Understand house styles and recognise best design practices

**Data files**

Data files needed to complete the activities in this section are provided in the Section 6 data files folder. Publications that you create or edit can be saved to the same folder.
6.1 Using Microsoft Publisher

Desktop publishing programs allow you to create high-quality documents using a range of advanced text and image layout tools. These documents are traditionally printed, but they can also be saved in a simple picture format for use on websites or in e-mail marketing campaigns. Typically, desktop publishing software is useful for creating:

- Leaflets, flyers, greeting cards, business cards and headed letters
- Brochures, magazines, certificates, menus and newsletters
- Advertisements, posters, signs and banners

Unlike word processors, desktop publishing applications place a far greater emphasis on page layout and design, giving you much more control over the positioning and appearance of text and images on the page.

Note: For professional publications, a dedicated printing company is often used to produce large quantities of a publication quickly and cheaply.

Microsoft Publisher is a desktop publishing application which is an appropriate choice for any task that requires an illustration or well-designed document containing a lot of pictures or graphics. The entry, layout and formatting of text is easily handled by such a program, as is the ability to import and arrange different types of object such as images, tables and charts.

Note: Microsoft Word and Publisher both look and work in very similar ways. However, each application is better suited to creating specific types of document. As a simple rule of thumb, if your planned document is mainly text based, use Word; if it is largely visual with lots of images, use Publisher.
6.2 Creating a Publication

When you create a new publication, you must first choose a page size using one of Publisher’s built-in templates. The most commonly used page size is A4.

**Note:** Ready-made templates containing professionally designed background illustrations and pictures are also available to use. You will get the chance to explore these templates in a later exercise.

**Activity:**

1. Start Microsoft Publisher. When the application opens, the Available Templates window is automatically displayed. Examine the various template types available in the Most Popular and More Templates groups. You will look at these again later.

2. As part of her advertising campaign, Julia would like to create a new poster for the Laser Show. She wants it to be A4 in size so that she can print it on her office printer. Select the Blank A4 (Portrait) template by clicking it once.

3. A new blank publication is created, ready to add your own text and graphics. Examine the Publisher window. In particular, locate the familiar File tab, Ribbon, Status Bar, Quick Access Toolbar and Zoom controls.

**Note:** Of course, once you have chosen a publication template, it is possible to change the size and orientation of the page at a later time.
4. Locate the **Page Navigation** pane on the left of the window. This will display small previews (or thumbnails) of all of the pages in your publication. Clicking a thumbnail will open the page in the main editing window.

5. Locate the **Rulers** at the top and left of the editing window. These can be used to position objects on the page and control text indentation (similar to *Microsoft Word*).

6. Leave the blank publication open for the next exercise.

### 6.3 Text Boxes

Unlike *Microsoft Word*, text in *Publisher* is not simply typed directly onto the page. Instead, it needs to be placed in one or more **text boxes**. Each box can be resized and repositioned any way you like, and there is no limit to the number of boxes that can appear on a page.

**Activity:**

1. With the blank publication created in the previous exercise still on screen, click the **Draw Text Box** button in the **Objects** group on the **Home** tab.

2. The mouse pointer changes to a crosshair, \(\uparrow\). In the centre of the current page, click and drag to create a text box of any size. Notice that, as you create the text box, its exact location and size are displayed on the **Status Bar**.

3. When you release the mouse button a text box appears on the page with the cursor flashing inside it, ready for text to be entered.

4. Press the \(<F9>\) key on your keyboard. The view zooms to **100%** on the current text box.

**Note:** Pressing \(<F9>\) again returns to the previous zoom level.
5. Notice that the text box has standard resize and rotation handles. These will always appear when a text box (or any other object) is selected.

6. Display the **Drawing Tools - Format** tab on the **Ribbon** and locate the **Size** group. The options shown here can be used to precisely position and resize any object on a page.

7. Change the value in the **Shape Height** box to **6 cm** and the **Shape Width** to **17 cm**. Notice the effect that this has on the text box.

8. Click the **Measurement** button to display the **Measurement** dialog box. The exact position, size and rotation of the selected object can all be changed here. Change the x value to **2 cm** and the y value to **1 cm**.

9. Click the **Close** button, on the **Measurement** dialog box to hide it. The text box has now been precisely resized and positioned on the page. Notice the object’s location and size on the **Status Bar**.

10. Leave the publication open for the next exercise.

### 6.4 Zoom Levels

You have already used <F9> to zoom in and centre on a selected object. As with other Microsoft Office applications, more precise zoom levels can also be selected on the **View** tab.

**Activity:**

1. With the empty text box created in the previous exercise still selected, display the **View** tab and locate the **Zoom** group. Examine the various zoom controls available, and then click **Whole Page**.
2. The zoom level is decreased so that the entire current page is displayed in the main editing window.

3. Next, click **Page Width** to zoom in so that the full width of the page fills the main editing window.

4. Finally, click **Selected Objects**. The zoom level is increased so that the selected text box fills the screen.

5. Leave the publication open for the next exercise.

### 6.5 Entering Text and Best Fit

When you enter text into a text box, you can edit and format it using a range of standard **Font** and **Alignment** features. Also, a really useful tool called **Best Fit** (also known as **AutoFit**) allows you to automatically increase a text box’s font size to fill the space available.

**Activity:**

1. With the empty text box created in the previous exercise still selected, type the following text as accurately as possible:

   The Light Fantastic
   An Amazing New Show

2. Display the **Text Box Tools - Format** tab and click the **Text Fit** drop-down button in the **Text** group. From the options that appear, select **Best Fit**. The font size of the text is increased to fill the available space in the text box.
3. Using the bottom **Resize** handle, reduce the size of the text box to **approximately 2 cm** (remember that you can use the **Object Size** information on the **Status Bar** to help).

4. The size of the text in the text box is automatically reduced to fit. Click **Undo** on the **Quick Access Toolbar** to undo your last action.

5. To disable **Best Fit**, display the **Text Box Tools - Format** tab and select **Do Not Autofit** from the **Text Fit** drop-down button.

6. Select the *first* line of text in the box and set the **Font Size** to **58** point. Then, select the *second* line of text and set the **Font Size** to **36** point.

7. Next, select *all* of the text in the box and, using the **Font** group, select the font **Impact**.

   **Note:** It is important to select the right font for the job. **Impact** is a good, strong, sans serif font that will be easy to read from a distance – perfect for a poster.

8. With all of the text still selected, click the **Align Center** button in the **Alignment** group. The text is centred in the box.

   **Note:** Familiar text alignment and formatting options such as **Bold**, **Italic**, **Underline**, and **Font Color** are all available in the **Font** group on both the **Format** and **Home** tabs.

9. Save the publication as **poster** in the data files folder for this section.

10. Leave the publication open for the next exercise.

### 6.6 Border and Shading Effects

A simple border of any colour or thickness can be added to a text box to mark its boundaries. A variety of shading effects can also be applied to improve the design of a publication.

**Note:** Borders can also be added to any other object (e.g. graphics, tables, charts, etc).
Activity:

1. With the poster publication open from the previous exercise, adjust the zoom level to Whole Page. Then, create a new text box with the following dimensions:

   ![Measurement Chart]

2. Zoom in on the new text box and enter the following text as accurately as you can:

   Now Showing
   at the Laser Show arena
   09:00, 10:30, 12:00, 13:30, 15:00, 16:30

3. Select all of the text and change the Font to Impact. Then, align the text so that it appears in the very middle of the box.

4. Apply a Font Size of 36 to the first line, 28 to the second line, and 20 to the third line. Adjust the zoom level to Whole Page to see the effect.

5. To apply a border to the selected text box, display the Drawing Tools - Format tab and examine the options available.

6. In the Shape Styles group, click the Shape Outline button. From the Scheme Colors available, select any colour of your choice. A border is applied to the text box.

7. Display the Shape Outline drop-down menu again and expand the Weight submenu. From the line weights shown, select 6 pt. The border’s thickness is increased.

8. Next, click the Shape Fill button, and select any colour of your choice. A background shade is applied to the text box.

9. Display the Shape Fill drop-down menu again and expand the Gradient submenu.
10. Select any of the options shown to apply that effect (notice that you can create a custom gradient using the More Gradients option at the bottom of the Gradient submenu).

11. Display the Shape Fill drop-down menu again and expand the Texture submenu. Select any of the options shown to apply that texture effect (notice that you can access more textures using the More Textures option).

**Note:** You can also use a picture as the background for a text box.

12. To apply a built-in shape style, display the Drawing Tools - Format tab and expand the Shape Styles box using the More button.

**Note:** Placing your mouse pointer over a thumbnail will display a ToolTip containing the style’s name. The effect of selecting that theme is previewed on the current page.

13. Explore some of the styles available, and then finally select Linear Up Gradient - Accent 1.

14. A simple gradient effect is applied to the text box and a faint border appears around the object. Click away from the text box to see the effect.

15. Select the text box again and display the Drawing Tools - Format tab. Click Shadow Effects to drop down a menu containing a variety of shadows. From the Drop Shadow group, select Shadow Style 4.

16. A simple but effective drop shadow is applied to the text box. Save the publication and leave it open for the next exercise.

### 6.7 Background Effects

Gradients, textures and pictures can also be used as a page background. In this exercise you will apply a simple, custom gradient.

**Activity:**

1. Display the Page Design tab and examine the available options.
2. Click the Background button in the Page Background group. Rest your mouse pointer over a thumbnail to preview the background effects on the page.

3. Select More Backgrounds to display the Fill Effects dialog box. Explore each of the tabs to see the types of effect that can be applied.

4. Display the Gradient tab and select Two colors from the Colors group. Select Orange for Color 1 (from the Standard Colours palette), and White for Color 2.

5. From Shading Styles, examine the options available and then select From corner. From the Variants section, select the bottom right thumbnail.

6. Click OK to apply the background effect. It fills the entire page.

7. Save the publication and leave it open for the next exercise.

### 6.8 Inserting a Picture

Any image file stored on your computer (or accessible from it) can be included in a publication. This includes pictures downloaded from the Internet (assuming you have permission to use them, of course), photos downloaded from your digital camera or mobile phone, or files produced by graphic image programs such as Adobe Photoshop or Paint Shop Pro.
Activity:

1. To insert a picture on the current page of the open **poster** publication, display the **Insert** tab and click the **Picture** button in the **Illustrations** group.

2. Locate the data files folder for this section, select the **Rocket** image, and click **Insert** to import the file. A picture of a rocket appears in the centre of the page.

**Note:** As with all objects in **Publisher**, pictures can be moved, resized and rotated.

3. By default, text in a publication is wrapped around an inserted image. From the **Picture Tools - Format** tab, drop down the **Wrap Text** button in the **Arrange** group and select **None**. The automatic text wrapping is disabled.

4. Use the **Size** settings to change the **Shape Height** of the picture to **17 cm**. The width of the picture is automatically adjusted to keep the picture in **proportion**.

**Note:** It is important to maintain the **proportions** of pictures and other objects such as charts when resizing them. If you do not they will become distorted.

5. From the **Arrange** group, click the **Align** drop-down button and select **Align Middle**. Then click the **Align** button again and select **Align Centre** to place the picture in the very centre of the page.

**Note:** If the **Align** options are greyed out, first select **Relative to Margin Guides**.

6. The rocket appears on top of the lower text box. From the **Arrange** group, click the drop-down button to the right of the **Send Backward** button and select **Send to Back**.

7. The rocket image now appears behind the text box.

**Note:** All objects on a page are placed on their own **layer** in a stack, rather like a deck of cards. The items higher up the stack appear on top of all other objects below. To move an object up or down the stack, use **Bring Forward** or **Send Backward**.

8. Well done! **Julia’s** poster is now complete.

**Note:** A model solution named **Sample Poster** is available in this section’s data files folder for comparison.
Section 6: Microsoft Publisher

6.9 Layout Guides

Layout Guides are lines on a page which act as visual aids to help you line up objects. More importantly, you can also snap objects to them using drag and drop.

**Note:** The most useful Layout Guides are Ruler Guides, Margin Guides and Grid Guides. Ruler and Margin Guides are used in this exercise; Grid Guides are used in 6.10.

Activity:

1. Open the file Layout from the data files folder. This simple publication features one text box and three shapes on a single page.

2. Display the Page Design tab and click the Guides button in the Layout group.

3. A variety of built-in guides are shown. From the bottom of the drop-down menu, select Add Horizontal Ruler Guide. A green dotted line appears across the middle on the page.

9. Save the publication and close it, but leave Publisher open for the next exercise.